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Microsoft Word

Saving Documents

e The first time you save a J EIEN R e
document, Word automatically = — — -
does a Save As when you click on M = | Ll [ &

the disk icon
e Every other time that you save a
document, Word does a regular
Save which overwrites your
document each time
e Save As can be used to make a new document with a new
name and/or new location, which does not overwrite your

original document Save As 7]
@ @K iR ok

Save in: :ﬂ Deskhop

g My Computer

g Web Folders

(=3 Lbusdwin9s (C:)
& o
[Z1 Miss anthory
[Z1 Mew Folder
_—ﬁg FTP Locations
,;E,] AddModify FTP Locations

KA

Save As

Open a document

Click File, then Save As
3. Click on small black arrow
to select file location

5

N —

. _‘ Flemame:  [Doc3 =] H s I
4. DOUbIe'chk On FOIder SRR Save as bype: :WgrdDgcument j Canicel
Name and click Save
Templ
emplate Mac

Format: | v Microsoft Word document

(NSNS0 Document Template

Text Only
Text Only with Line Breaks

1. Create a document that you would like to
use repeatedly as a template

Click File, then Save As ws-posTex:
3. Click on small black arrow next to Save as type: | Rich Text Format

pining boume  |njcode Text

(Format on Mac) and select Document “—- Web Page

"""" Stationery

Template and click Save e e Dicuonary

________ Word 4.0 for the Macintosh
"""" Word 5.0 for the Macintosh

******* Word 5.1 for the Macintosh

N
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Microsoft Word

FI Ie Locat Ions J Wiew | General | Edit | Prink I Save | Speling & Grammar |

Track Changes I User Information I Compatibility File: Locations

1. Click Tools, then Options

( W 0 rd y t h e n Prefe re n ce S 0 n a UserI:;empates | 'l, . .'I,Microsoft'l,epltes o
- - '] roup templates
M aC) ] t h e n FI I e Locat I o n S gfl?gr«‘oepé::?\l?:r files Ci'l,. . Japplication DatalMicrosoft),...
2. Click Modify St AR
3. Click on small black arrow to locate

folder of choice and click OK

® All new files will automatically be
stored in your folder of choice

CK | Clase I

Locat ing Fi Ies £ Find: All Files

File Edit Yiew Options Help

1. Click Start, then Find, then Files

Mame & Location | Date | Advancedl

or Folders (On Mac OS X, click ot [ —~ |
the desktop, then click File, then - NS;Eh|
Find. On Mac OS 9, click Apple, e = C'%
then Find File) ¥ Include subfalders Browse...|

2. On Windows XP, type *.doc (The

symbol * is a wildcard and .doc is

the file extension for a 86 Find
document! SO the Computer Wl” Search in: Specific places = Add
find all documents on your hard = S ™

drive) ™ =} Macintosh HD

3. Select C-drive (Hard Drive on a
Mac) and click Find Now

Search for items whose:

Kind o [is 5] " document | O F
4. Hold Ctrl (Command on a Mac) on ——— —— =
your keyboard to select multiple E—

(" Search )

files to cut or copy, and move to
a new location
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Opening Documents

e Open the folder where you
save your documents
e Double-click on the document

to

Deleting Documents

e Open the folder where you save

open it

your documents

e (lick on the document to select it

& Professional Development [_ (O] x]

JEiIe Edit ¥iew Go Favorites Help |

j@-»-@‘%

Back Reinviziel g Cut Copy Faste

= = = =2 =5 = 0N

Spring 2003 Staternent  STULL O Stull Technal.. TTRAC-
training  of Purpose Lesson 01 Standard..  Finnacl.

) W) ) W) B e

TTRAC TTRAC TTRAC TTRAC TTRAC  ‘Welcome -
2003 E-M.. Agendas Gems Schedu... Sum 03 General

) E)] ®] W) W@ W

2

Welcome- Win Man,  Windows  Windows Warkshops
GroupWise Handouts Manage.. Manage..
]
(2]
Writing Stull Ewal
Scorin..  MemaoRE..
|1 objects) selectad |326I<EI |1_§‘ Wy Camputer i

e Push the delete button on your keyboard OR drag
the file to the recycle bin/trash

Printing Documents

e (lick on the printer icon to print to

your default printer

e (lick File, then Print for other print options

PC

Print HER
tinker
Mame: I 5 hp deskist 3820 series LI Properties |
Skatus: Idie
Tvpe: hp deskjet 3820 series
where: LPT1: I Print to file
Cormment:
age range Copie:
= gl Murnber of copies: I E‘
- Current page " Selection
" Pages: I

Erter page numbers andjor page ranges
separated by commas. For example, 1,3,5-12

1 1

1 1 ¥ Collate
ENE

Print wihat: IDocument

[ |

Prink: IAII pages in range

Options. .. |

[

Zaom

Pages per sheet: |1 page - l
Scale to paper size: IND Scaling - l

OK I Cancel I

| Eile Edit View Insert
B 0= m

Mac

KimAnderson@lbusd.k12.ca.us

Print
Printer: = No Printer Selected 71
Presets: Standard Ti
Copies & Pages _H
Copies: 1 ECOHated
Pages: I":”\II
) Current page
) From: 1 Tt "1

3 Page range:
Enter page numbers and/or page ranges
separated by commas (e.g. 2, 5-8)

(2) ( Preview ) ( Save AsPDF... ) ( Fax.. ) ( Cancel )
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View Options S

Wienwy Insert Farmat Tool

e (lick View, then Print El Mormal _
Layout (Page Layout on a 3 web Layout m |_
Mac) to see the document as | Bl rint Layaut _ I
it would be printed Qutline 500 %

e Make sure that Ruler is Tnolbars p | 1 200%
checked e [EERRSRET

e Use the pull-down menu on B Docurnent Map 100%,
the toolbar to change Header and Foater 7500

document magnification

ERminEies
53 COrmiments e
Full Screen 10%
Zoom.., Page ‘Width
Text Width
Whole Page

Twio Pages
Font

o m by clicking and dragging your mouse
over the words or lines,

e Double-click to select a single word, triple-click
to select a whole line

e (lick in the margin to the left of the line to select
the entire line

e Use the icons on the toolbar to

change the font type or size, or Tahoma r1le B I U

to use bold, italicize, or underline
e C(Click Format, then Font for other font formatting
options (See page 11 for default font)

KimAnderson@lbusd.k12.ca.us 5
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Line Spacing
Select text

e C(Click Format, then
Paragraph

e Use the pull-down menu to
select line spacing and click OK

OR

e Use the icons on the toolbar to
select single, 1.5, or double
line spacing

Alignment

e C(lick Format, then Paragraph
e Use the pull-down menu to
select alignment
OR
e Use the icons on the toolbar to
select left, center, or right
alignment

KimAnderson@lbusd.k12.ca.us

Paragraph

Indents and Spacing | Line and Page Breaks I

Alignment: Cutline level: IB.;..j\:,.- bek vl
Indentation
Lift: Special: By
Hanigin 0.35" —
Right: |Henging =] | =
Spacing
Before: Op —
Bfter: 1] s — j
Presview 1 Double
Al least
vcis Pl P Exactly
Mulkiple
|
Tahsf.. (o]4 I Cancel

3 7 U === ==
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future documents

Format->Paragraph)

click OK

B~

make changes

KimAnderson@lbusd.k12.ca.us

[Pagesetp —— HH|
M arg I ns Margins IPaper Size | Paper Source I Layout |
| Top: Im EA Preview
e Click File, then Page Setup I_:[ —
(On a Mac, click Format->Document) G [z = —
e Margins are measured in inches o —
e Change the margin sizes and click OK | *== < = -
. . Footer: 0.5 Apply bo: wWhale dacument -
e Click Default to use settings on all T Guttemsmln
™ 2 pages per sheet " Left " Top
e Click OK for this document only e | x| _cos |
Tabs 2]x]|
Tabs -
iLat' stop position: Default tab stops: 0,5" =
e Click Format, then Tabs (On an | s  pecml
older Mac using Word 98, click ;Qenter  Bar
Right
Leader
o Default tab stops are every 0.5 inch ::jl_mc-ne ::a -------
e Add new tab measurements and EiN .
Tah stops to be cleared:
e Tabs can also be added by clicking et | cea | clearar |
on the ruler, and moved by
dragging them along the ruler ok | concel |
Bz s s S
Page Header & Footer
Click View, then Header and Footer
Click inside header or footer to type [|uaanarost: -
. rigert AUt Text - 4] & FF Gy close
Click Close on toolbar to close st LT mogs ?C'
Double-click on Header or Footer to
----- I B R I H I S R
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Microsoft Word
Cut, Copy, & Paste
(MllSelect text

2. Cut text to remove it and put it on the clipboard or... Copy text
to just put it on the clipboard
3. Paste to insert the contents of your clipboard

Cut Copy _ Paste
Shortcut: .:IﬁI:- Shortcut: Shortcut:
Ctl‘|+X_ Ctl‘|+C_ Cirl + V =

(On a Mac, use the Command/Apple ¢ key instead of Ctrl)

J File Edit Yiew Insert Format Tools Table ‘Window

HEDz2 NR_REY | 4 BE oo

Undo or Redo last action
e Redo is available only after Undo
e Use little black arrow to undo or redo multiple actions

Columns U ====
1. M to put in columns ==
2. Click on the columns button and select the number :g :g
of desired columns — ||
3. Click Format, then Columns to make changes 2 Calumns

Bullets & Numbering
Select text = iz

Click on the Bullets or Numbering button
3. Click Format, then Bullets or Numbering to make changes

N —
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Track Changes

1. Click Tools, then Protect Document Protect document For
2. Click OK (If you intend to have several students | Zeeiene=
review the document, you might want to use a r F
password so that the document can only be
unprotected by you.) Password (optional):
3. Changes to the document will now be highlighted “
in red text and underlined or noted in a “balloon” [ ok ] cancel

e When you are ready to edit your work...
1. Click Tools, then Unprotect Document
(If necessary, enter your password)
2. Click Tools, then Track Changes
e On a Mac, click Accept or Reject changes

e On a PC, right-click on the changes and select Accept or
Reject changes

Reviewing Toolbar

Click View, then Toolbars, then Reviewing

Use the Comment button to insert messages to the writer
Use the Accept or Reject changes buttons

Use the Highlight button to highlight specific parts of the text
(On a PG, this button located on the Formatting toolbar)

Final Showing Markup — « Show - & 'EB‘;E} - ?E??\* 2 H .
Highlight & - Accept Reject

Changes Changes

KimAnderson@lbusd.k12.ca.us 9
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Customize Toolbars S
. . . Formatting
1. Right-click on tool bar and select Customize ALtOText
2. Click the Commands tab Control Toolbox
. . Database
3. Click on desired Category (ex: Form.at) Sl
4. Drag buttons from the Commands list onto Forms
your toolbar E:“m;;ge
5. Drag buttons that you never use off the toolbar Qutlining
6. Drag buttons on the toolbars in order to Pict.re
- Reviewing
rearrange them to your liking Tebles and Borders
Text Box
Fﬂ Wisual Basic
Eile Edit View Insert Format Tools Table Window Help Web
DEEHSE SRY sRRY v - QHOE=@| & 1 100% ~0B Web Tools
o —— - Y-Z-0-0-0-B@E B30 Ak 4. Word Count
~| Tahoma ~16 v B 27U [EE==1=-SEEE O N Vordart
— Customize. |
Drag Off _ \

Customize

Toolbars — Cormmands l Cpkians l

To add a command ko a koalbar: select a cakegory and drag the command
aut of this dialog box to a toaolbar,

Cakegories: Zommands: D
. = rag On
E:lﬁ: Mormal Skyle g
i

Wiz Single Spacing

Insert

1.5 Spacing

Toals
Table
Web

Wyindow and Help
Drawing - |

Double Spacing

Columns. .. -

Selected command:

Descripkion | |

EJ| Save in: [Mormal - kevboard. .. | Close |

KimAnderson@lbusd.k12.ca.us 10
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Auto-Text

1. Type and select text that you
want to use for Auto-Text

2. Click I nsert, then Auto-Text,
then New
Click OK

e Auto-text will now appear when
you start to type the word(s)

Create Au... FE

Word will create an AukaText entry
from the current selection,

Please name wour AukoText enkry:

Ik Cancel

Kim anthorny  {Press ENTER to Iﬂsert}|

Elirm xf-l

Default Font

Click Format, then Font
Select font preferences
Click Default...

Your preferred
font settings will
now be applied to
all future
documents

¢ wh~

KimAnderson@lbusd.k12.ca.us

Font l Character Spacing l Text Effects ]

Fonk: Fonk style: Size:
|Tah0ma |Bold
Regular
Teletype Ttalic
Times Mew Roman Bald Ttalic
Trebuchet M35
Font colar: Undetling skyvle:

Automatic j |(none) j |

Effects

[ skrikethrough [ shadow [ Small caps
[ Double strikethrough [ Sutline [ Allcaps
[ Superscript [ Emboss [~ Hidden
™ Subscript [~ Engrave
Preview
Tahoma

Thisz iz a TrueType Font. Thiz font will be used on both printer and screen.

Default... QF | Cancel

11
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1.

3.

AutoCorrect Options

Click Tools, then AutoCorrect Options
2. Uncheck the options that you do not like

Click OK

’AutoCorrect: English (U.S.)

x|

TI P — This option
is not good for
typing lists of

vocabulary words

—

Replace:

AutoTexk ]
AutoCorreck

v Show AukoCarrect Options bukbons

[v Carrect TWa INitial Capitals
’IV Capitalize first letter of sentences
Iv Capitalize first letker of table cells
|v Capitalize names of days
Iv Caorrect accidental usage of cAPS LOCK key
[v -Replace text as you bype

AukoFarmat ] Smart Tags ]

AukoFarmat As You Type ]

Exceptions...

with: T Plain bext {* Formatted text

AutoCorrect

v Other paragraph sty
Replace

W "Straight quotes" with “smart quokes”

v rdinals (1st) with superscript

v Fractions (12} with Fraction character {1&)

v Hyphens (--) with dash (—)

v *Bold* and _italic_ with real Formatting

W Internet and netwark paths with hyperlinks

Preserve
v Skyles
Always AukoFormat
v Plain text WaordMail documents

2 7%
AutoiCorreck I AukoFormat As You Type ]
AutoText AutoFormat Smart Tags |

-
: 4
~|

Iy use suggestions from the speling checker

o]

Cancel |

N

AutoFormat

e (lick the AutoFormat
tab to deselect other
options, such as
automatic numbering
(also known as

Automatic bulleted lists)

]

Cancel

KimAnderson@lbusd.k12.ca.us
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Making Tables in Microsoft Word

1. Open a new document Insert Table EHE
H H Table size
2' Type your tltle fIrSt Mumber of columns: m
3. Hlt enter (return on a MaC) Mumber af rows: |2 E‘
twice to leave space AUoFit behaior
. % Fixed column width: Im
4. C“Ck Table, then I nsert Table " AutoFit to contents
€ AutoFit ko window
5. Type the number of rows and e forms (o —
columns that you want and
CliCk OK [ Set as default for new tables
6. Right-click on the toolbar at ok | concel |

the top to make sure the
Tables and Borders Toolbar
is showing

Typing Text in Cells

e Put your cursor in the cell by clicking in the
center of the cell (you’ll see a blinking cursor)

e Move to next cell by using the arrows or

|T Standard

IT Formatting
AutoText
Clipboard
Control Toolbox
Database
Cirawing
Farms
Frames
Picture

Reviewing

|T Tables and Borders

isual Basic
YWilet

Web Tools
WilordArt

Custormize...

the tab button |

Formatting Text

e Select text as you do in regular word processing

e Drag your mouse over

IEiEfl erchad tex

the words

e Double-click on words

e When text is selected, change alignment, font size,
style, etc. Put your cursor in the cell by clicking in the

center of the cell

e Move to next cell by using the arrows or the tab button

KimAnderson@lbusd.k12.ca.us
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TeXt Alignment t1 - Microsoft Word

v Ingert Format Tools Tahle Window Help |BA g= ﬂvé

e Select text, cell, row, or column

. ||3.§“~B—9 %E‘®'|ﬂvﬂv,JTatha v|14'r
e (Click the small b_Iack TR = SR
arrow on the Align Text A e
button on the toolbar . Egg
e (Click on desired alignment 3 ===
|

Working with Cells

To select a cell...

e Move the arrow to the left of
the inside of the cell until you
get a black arrow, then click

e To select multiple cells, click
and drag your mouse

Working with Rows

To select an entire row...
e Move the arrow to the left of the row

"l
until you get a white arrow, then click
e To select multiple rows, click *
and drag your mouse

Working with Columns

To select an entire column...
e Move the arrow above the column
until you get a black arrow, then click
e To select multiple rows, click
and drag your mouse

KimAnderson@lbusd.k12.ca.us 14
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Borders

e Select a row or column
e Click on the small black arrow to select border line type
e Click on the small black arrow to select border line weight

e Select which border to apply selected border style\

J_ﬂ? {E‘ - 1f2|:*£‘--§--*@!v

Border Type Line Weight
- Borders and Shadin EHEB
Shading S oy |
e Select a row or column _FFQEEEE
e Click Format, then Borders and
Shading
e (Click on the Shading tab at the top
e Select Style under Pattern and click OK = =
coneel |

E N Diagonal
. :I i & i
hsert Format Tools Table Window Help| .@| -3 ttﬁ'f.f'@"a'
Ep E‘g|ﬂ' NT?JTa
Insert RDWS

— & 2o = I nserting Rows
- ED I SO & and Columns

e Select an entire row or column

% e (Click the I nsert Rows button

on the toolbar

Resizing Rows and
Columns <«||->

e Select a row or column

e Put mouse on the wall that you want
to move and the pointer will chanage

KimAnderson@lbusd.k12.ca.us 15
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Distributing Rows and Columns

e Select multiple rows or columns Rows

e Click the button on the toolbar to Distribute Columns
Rows or Columns evenly
e ,”._..._._. - -

- 1;'2|:7J?”_ & -

Merging Cells [nsert Format Tools Table Window Help E‘“ ‘gl_[
Epy Eg|ﬂv ﬁv,JTatha -

e Select multiple cells

to merge — 5 wirdO- D [ B3
e (lick the Merge E 1 .3.......&. |
Cells button on the % S MEFEIE CE”5|

tnnlhar ‘ ‘ \

Sorting Text

Select multiple rows to sort
Click the Sort Ascending button on the toolbar to sort alphabetically
All text in the row will be sorted according to the text in the first row

4t 1 ALl &) = .

Text Direction

Click to put your cursor in the cell with the text
Click the Text Direction button on the W:ﬁ | 51 2] =
toolbar to chanae the direction of the text v T

KimAnderson@lbusd.k12.ca.us 16
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Envelopes

1. Click Tools, then Letters and
Mailings (Options on older
versions of Word), then
Envelopes and Labels (On a
Mac, click Tools—>Envelopes)

Envelopes and Labels

Envelopes I Labels ]

Delivery address:

2?X

[ - Print

2. Type the Delivery address
in the space provided

3. Your Return address may
already appear in the space
(if not, type it)

4. If you want to save it in a

Add to Docurnent

Cancel ‘

opkions. ..
W
E-posktage Properties...
[ &dd electronic postage
Return address: - [ Dmit
Preview Feed
\. -
- ]
W

‘wWhen prompted by the printer, insert an envelope in wour printet's manual feeder.

document, click Add to
document

5. If you just want to print it, click print (note the printer feed and
make change if necessary— Click Options)

[?)X]

Envelopes and Labels

Envelopes £ Labels | |
Address: B -~ [ Useretorn address Print |
s
MNeww Document |
Cancel |
Opkions. .. |
w
E-postage Properties... |
r Label
Prink Avery standard, 2160 Mini
' Full page of the same label Address
" Single label
™ Add elect
Label Options ?
Before printing, irf
i & Printer information
" Dat matrix
% Laser and ink jet Tray: |Manual Feed d
Label information
Label products: |Avery standard j

Product nurmber:

Label information

5096 - Diskette ﬂ

5097 - Diskette Type: Address

5159 - Address IC_| Height: G

5161 - Address ) 2,63"

5162 - Address Page size: Letter {8 ¥ x 11in)

5163 - Shipping ﬂ

Details. .. | Mew Label. .. | | [al4 | Cancel |

N

KimAnderson@lbusd.k12.ca.us

Labels

Click Tools, then Letters and
Mailings (Options on older
versions of Word), then
Envelopes and Labels (On a
Mac, click Tools—>Labels)

(PC only) Click on the Labels tab
Type the desired text in the
space provided (for a full

page of the same label)

Click Options to select label

If you want to save it or work
on it in a document, click
New Document

If you just want to print it,
click Print

17
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Drawing Tools

e Right-click on toolbar (or click View, then Toolbars) and select
Drawing to open the Drawing Toolbar

JD[aw- [+ & | AutoShapes » ™. \l:l@‘@”lglvivi-f

e Commonly used drawing tools include:
AutoShapes, Text Box, Lines & Arrows, WordArt

e You can change the Fill Color, Line Color and Line Thickness or
Line Style, by clicking on the object, then using the buttons below

Fill Color Line Styles

Mac / /Line Color 1 \
., . Draw —_—
& Menu iunes >| 2‘ b -.:'F b A  mm O 1—&'
— @ Basic
h’ B, Block Arrows » %E ? <
Za Elowchart > SRectangiel Line Thickness
f&: Stars and Banners  »
T b ¥y Callouts 4 g g —
AL T e, 52| [N %O E 4l (3
WordArt |Agh:|5hap95v\ W O™ )
A oraar ol [ m )L 7> \
EEY| Line & Textbox WordArt
= AutoShapes  Arrow Tools
% Draw Menu 1 o
. Elgngmup
Commonly used tools include: s
[] y _ I RETlp
— e Order - Bring to Front or Send . ,
S to Back (Arrange on Mac) s o
i 7 e Align — Top, Middle, Bottom, udge b
__ Line Left, Center, or Right align or Disribute b
— ) . . . Fotate or Flip 4
_ Thickness e Distribute — Horizontally or
= Vertically R
-# = Line Color e Rotate — Left or Right Change AutnShape b
_{-J":. = Fill Color i F“p - Horizonta”y or Vertica”y Set autoShape Defaults

|D[an [% G; | autnShapes «

PC TIP - If a drawing canvas appears automatically, you can remove it by clicking
Tools>Options>General, then uncheck the Drawing Canvas option

KimAnderson@lbusd.k12.ca.us
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Clip Art

Insert Clip Art v X

1. C“Ck Insert, then Picture, then Clip Art Search For
(or click the clip art button on the "ﬁ 5:“::;:3/
Drawing Toolbar) o
e Click From File if your clip art is stored Other Search Options
on a disk or in a folder _ -
2. Type a word to search for clip art and click Search  resis shousbe:
3. Click on desired clip art to insert (or double-click) Allmecta e types ¢
4. Close the clip art window
5. Double-click on the clip art to format it
6. Click on the Layout tab, click Tight, B
and CIle OK z] IInsertCIipArt - X
7. Click and drag the small white circle on 7] (Gearing..)
the corner of the clip art to resize "
ColorsandLines] Size: Layout lPicture ] ] Web ]
Wrapping style
o ‘ ~ i = ‘ b &
In line with tesxt Sguare Tight Behind ket In front of kext ‘E‘
Horizontal alignment - i u
" Left " Center " Right + Other ) e
Insert T
Copy 'Q
¥ Delete from Clip Organizer 5@
Open Clip In...
Advanced... Tools on the Web. .. ——
5 Copy to Collection. .. |
’Tl Cancel |
Edit Keywords. ..
Default Layout: Recommended Layout: —
- - - e e ing Clips
Inline with text  Tight or I n front of text 2]

&L H 12:52 AM

S {
1

KimAnderson@lbusd.k12.ca.us 19
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Customize Picture Options

—

Click Tools, then Options
Click on the Edit tab

N

| nsert/ paste pictures as:
Select a different default
layout and click OK

Security ] Spelling & Grammar l Track Changes
User Information ] Caompatibility l File Locations
Wig General Edit l Print l Save

General options
I
[ Blue background, white ket
| Provide feedback with sound
v Provide feedback with animation
[ Confirm conversion at Open
v Update autarnatic links at Open
[v Mail as attachment
v Recently used file list: |4 E: entries
I Help For WordPerfeck users
[ Mavigation keys For WardPerfect users
I &llow background open of web pages
[ idutomatically create drawing canvas when inserting Autoshapes:

Inches -

[ Show pizels for HTML features

[MQasurement uniks:

Wweb Options. .. | E-mail Options. .. |

Click on the small arrow under

l
l
l

Security l Spelling
User Information l
Wigw ] General
Editing options

¥ Typing replaces seleckion
Iv Drag-and-drop text editing
Use the IMS key for paste
ertype mode

Pickure £

|Micru:usu:uFt Wol

[~
-

Insertfpaste pictures W

|In line with text

& Grammar l Track Changes
Compatibility ] File Locations
Edit Print | Save

[ Allow accented uppercase in French
v se smart paragraph selection
v Use CTRL + Click bo Fallove hyperlink.

v When selecting, aukomatically select
entire word
[~ Prompt to update style

v Keep track of Formatting
[ Mark Farmatting inconsistencies

C
o
c H Square

In line with bext

Tight

Behind text

In front of text

Through

b Sl Gl §

Top and bottom

[v Smart cut and paste Settings...

=]

Marmal

l
|
l

o |

Cancel

Cancel

o]

—

Click Tools, then Options
Click the General tab

N

| Customize Drawing Options

uncheck the box next to Automatically create

drawing canvas when inserting AutoShape

KimAnderson@lbusd.k12.ca.us

20




